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MỞ	ĐẦU	

Việc dạy học trực tuyến cho học sinh (sau đây viết tắt là HS) không phải là nhiệm 
vụ mới đối với giáo viên (sau đây viết tắt là GV) vì nhiều địa phương đã tổ chức triển 
khai trong hai năm qua để ứng phó với những ảnh hưởng của dịch bênh Covid-19. Đến 
nay, nhiệm vụ này tiếp tục cần được tăng cường hơn nữa (theo hướng chuyển từ ứng 
phó tình thế sang chủ động theo kế hoạch) khi chúng ta bước vào năm đầu tiên thực 
hiện Chương trình giáo dục phổ thông 2018 đối với cấp trung học cơ sở trong bối cảnh 
dịch bệnh tiếp tục có những diễn biến phức tạp. Các địa phương và các nhà trường đã 
có những kinh nghiệm được đúc kết trong hai năm qua, đặc biệt là đã có đầy đủ những 
căn cứ pháp lí để xây dựng và tổ chức dạy học một cách linh hoạt nhằm mục tiêu kép: 
không chỉ thích ứng với diễn biến mới của dịch bệnh Covid-19 mà còn đẩy nhanh quá 
trình chuyển đổi số trong giáo dục, từng bước nâng cao chất lượng giáo dục và đào tạo. 
Cụ thể là: 

– Điều 32, Luật Giáo dục số 43/2019/QH14 quy định Chương trình giáo dục phổ 
thông “được tổ chức thực hiện linh hoạt, phù hợp với điều kiện cụ thể của địa 
phương và cơ sở giáo dục phổ thông”. 

– Nghị định số 24/2021/NĐ-CP ngày 23 tháng 3 năm 2021 quy định việc quản lý 
trong cơ sở giáo dục mầm non và cơ sở giáo dục phổ thông đã nêu rõ trách nhiệm và 
quyền hạn của người đứng đầu cơ sở giáo dục tại Điều 9 là “Tổ chức thực hiện kế 
hoạch tuyển sinh, kế hoạch giáo dục của nhà trường, kế hoạch quản lý tài chính, tài 
sản, tổ chức bộ máy và nhân sự của cơ sở giáo dục; quản lý, sử dụng các nguồn lực xã 
hội hoá, đảm bảo đúng mục đích, công bằng, công khai, minh bạch”; trách nhiệm và 
quyền hạn của GV tại Điều 10 là “Tham gia xây dựng và thực hiện kế hoạch tuyển sinh, 
kế hoạch giáo dục của nhà trường, kế hoạch quản lý tài chính, tài sản, tổ chức bộ máy 
và nhân sự của cơ sở giáo dục theo chức năng, nhiệm vụ được phân công.”. 

– Điều 19, Thông tư số 32/2021/TT-BGDĐT ngày 15/9/2020 ban hành điều lệ 
trường trung học cơ sở, trung học phổ thông và trường phổ thông có nhiều cấp đã quy 
định rõ: “1. Các hoạt động giáo dục thực hiện theo kế hoạch giáo dục của nhà trường, 
được tổ chức trong và ngoài giờ lên lớp, trong và ngoài khuôn viên nhà trường, 
nhằm thực hiện chương trình các môn học, hoạt động giáo dục trong Chương trình 
giáo dục phổ thông do Bộ trưởng Bộ Giáo dục và Đào tạo ban hành. 
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2. Hoạt động giáo dục thông qua một số hình thức chủ yếu: học lí thuyết, làm 
bài tập, thực hành, thí nghiệm, thực hiện các dự án học tập, tham quan, cắm trại, 
đọc sách, sinh hoạt tập thể, câu lạc bộ, hoạt động phục vụ cộng đồng.” 

– Công văn số 5555/BGDĐT-GDTrH ngày 08 tháng 10 năm 2014 và Công văn 
số 5512/BGDĐT-GDTrH ngày 18 tháng 12 năm 2020 đã hướng dẫn cụ thể các bước 
tổ chức một hoạt động học và nêu rõ bài học cần được thiết kế thành các hoạt động 
học, tạo điều kiện thuận cho việc tổ chức hoạt động đề cập trong tài liệu này. Đồng 
thời, căn cứ vào Công văn số 3699/BGDĐT-GDTrH ngày 27 tháng 8 năm 2021 về việc 
hướng dẫn thực hiện nhiệm vụ năm học 2021 – 2022, GV sẽ được hướng dẫn xây dựng 
kế hoạch bài dạy trực tuyến theo hướng chú trọng học lý thuyết và làm bài tập khi kết 
nối trực tiếp và lựa chọn hình thức phù hợp cho các hoạt động vận dụng để HS tự học 
và nộp sản phẩm. Với tinh thần đó, tài liệu này được biên soạn một cách ngắn gọn nhằm 
giúp GV có thể thiết kế và tổ chức thực hiện kế hoạch bài dạy một cách phù hợp với 
các công cụ công nghệ được lựa chọn linh hoạt tùy thuộc điều kiện của GV, HS và nhà 
trường. 

I. Mục tiêu 

– Nâng cao kĩ năng tổ chức dạy học trực tuyến cho GV; điều chỉnh việc tổ chức dạy 
học trực tuyến theo hướng tăng thời lượng làm việc chủ động của HS, giảm thời lượng 
kết nối thời gian thực. 

– Định hướng xây dựng kế hoạch bài dạy trực tuyến; hướng dẫn một số bước cơ bản về 
việc tổ chức dạy học trực tuyến đối với mỗi bài học. 

– Tăng cường năng lực tự lựa chọn và sử dụng một số công cụ/ nền tảng công nghệ 
thông tin trong dạy học trực tuyến. 

II. Đối tượng 

– Tài liệu được sử dụng để tập huấn tăng cường năng lực dạy học trực tuyến cho GV 
cấp trung học cơ sở và trung học phổ thông.  
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PHẦN	1:	MỘT	SỐ	VẤN	ĐỀ	CHUNG	(KÈM	THEO	1	VIDEO)	

I. Các căn cứ tổ chức triển khai 

1. Thông tư số 32/2018/TT-BGDĐT-GDTrH ngày 26 tháng 12 năm 2018 ban hành 
Chương trình giáo dục phổ thông. 

2. Thông tư số 09/2021/TT-BGDĐT ngày 30 tháng 03 năm 2021 quy định về quản lí 
và tổ chức dạy học trực tuyến trong cơ sở giáo dục phổ thông và cơ sở giáo dục thường 
xuyên. 

3. Thông tư số 22/2021/TT-BGDĐT ngày 20 tháng 7 năm 2021 quy định về đánh giá 
học sinh trung học cơ sở và trung học phổ thông. 

4. Công văn số 5555/BGDĐT-GDTrH ngày 08 tháng 10 năm 2014 về việc hướng dẫn 
sinh hoạt chuyên môn về đổi mới phương pháp dạy học và kiểm tra, đánh giá; tổ chức 
và quản lý các hoạt động chuyên môn của trường trung học/trung tâm giáo dục thường 
xuyên qua mạng. 

5. Công văn số 4612/BGDĐT-GDTrH ngày 03 tháng 10 năm 2017 về việc hướng dẫn 
thực hiện chương trình giáo dục phổ thông hiện hành theo định hướng phát triển năng 
lực và phẩm chất học sinh từ năm học 2017 – 2018. 

6. Công văn số 3280/BGDĐT-GDTrH ngày 27 tháng 8 năm 2020 về việc hướng dẫn 
thực hiện điều chỉnh nội dung dạy học cấp THCS, THPT. 

7. Công văn số 2613/BGDĐT-GDTrH ngày 23 tháng 6 năm 2021 về việc triển khai 
thực hiện chương trình giáo dục trung học năm học 2021 – 2022. 

8. Công văn số 3699/BGDĐT-GDTrH ngày 27 tháng 8 năm 2021 về việc hướng dẫn 
thực hiện nhiệm vụ năm học 2021 – 2022. 

9. Công văn số 5512/BGDĐT-GDTrH ngày 18 tháng 12 năm 2020 về việc xây dựng 
và tổ chức thực hiện kế hoạch giáo dục của nhà trường. 

10. Công văn số 4040/BGDĐT-GDTrH ngày 16 tháng 09 năm 2021 về việc hướng dẫn 
thực hiện Chương trình GDPT cấp THCS, THPT ứng phó với dịch Covid-19 năm học 
2021-2022.  

II. Định hướng xây dựng kế hoạch giáo dục 

1. Xây dựng kế hoạch giáo dục của nhà trường theo hướng dẫn điều chỉnh nội dung dạy 
học của Bộ GDĐT, trong đó đảm bảo yêu cầu thực hiện các nội dung cốt lõi. 
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2. Xây dựng các phương án dạy học trực tuyến và trực tiếp để chuyển đổi linh hoạt, 
ứng phó kịp thời với các tình huống diễn biến của dịch Covid-19 tại địa phương. 

3. Ưu tiên dạy học trực tuyến đối với các nội dung mang tính lí thuyết, có thể hướng 
dẫn HS khai thác sử dụng hiệu quả sách giáo khoa để học tập. 

4. Sẵn sàng phương án để tận dụng tối đa khoảng thời gian HS có thể đến trường để 
dạy học trực tiếp, nhất là đối với các nội dung thực hành, thí nghiệm và kết hợp ôn tập, 
củng cố những nội dung lí thuyết đã học trực tuyến. 

5. Thực hiện hiệu quả, chất lượng các hình thức, phương pháp dạy học và kiểm tra, 
đánh giá trực tiếp và trực tuyến.  

III. Định hướng xây dựng kế hoạch bài dạy trực tuyến 

1. Xác định nội dung bài học khi dạy học trực tuyến 

Khi dạy học trực tuyến, GV cần chú ý xác định đúng nội dung cốt lõi của bài học, 
đảm bảo tính khả thi, tăng thời lượng làm việc chủ động của HS, giảm thời lượng kết 
nối trực tuyến thời gian thực. Sau đây là một số định hướng điều chỉnh: 

 

Xác định cụ thể những yêu cầu cần đạt đối với mỗi bài học không thể thực hiện được 
trên môi trường mạng.

Điều chỉnh mục Hêu bài học theo hướng Hnh gọn tập trung vào các nội dung 
cốt lõi gắn với YCCĐ trong Chương trình giáo dục phổ thông.

Đánh giá để phân loại những nội dung mà HS có thể thực hiện được một cách 
tự chủ (có thể chỉ một phần) để giao nhiệm vụ cho HS.

Lựa chọn những nội dung có thể thay thế việc giảng trực Hếp bằng một học liệu 
điện tử (hình ảnh/ âm thanh/ video).

Lựa chọn phương án và phương Hện để kiểm tra, đánh giá thường xuyên; kịp thời điều 
chỉnh quá trình dạy học, quá trình học tập và biện pháp phối hợp với gia đình.
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2. Xây dựng kế hoạch bài dạy (giáo án) trực tuyến 

Việc xây dựng kế hoạch bài dạy (trực tiếp hay trực tuyến) đều cần lưu ý những điểm 
chính sau đây: 

- Căn cứ vào yêu cầu cần đạt trong Chương trình GDPT 2018 (đối với lớp 6) và căn 
cứ vào Mức độ cần đạt trong Chương trình GDPT 2006 (đối với lớp 7-12) để xác 
định mục tiêu bài học. 

- Sau khi xác định được mục tiêu của từng hoạt động trong tiến trình dạy học, ta cần 
gia công thiết kế từng hoạt động.  

- Trong quá trình thiết kế từng hoạt động, ta cần xem xét để lựa chọn thiết bị dạy học 
và học liệu phù hợp cho từng hoạt động tương ứng.  

- Với cùng một mục tiêu, có thể có nhiều phương án thiết kế hoạt động tuỳ thuộc vào 
điều kiện về thiết bị dạy học, học liệu và đối tượng HS.  

- Việc vận dụng các phương pháp, kĩ thuật dạy học tích cực khác nhau cũng cho ta 
các phương án khác nhau để đáp ứng được mục tiêu của từng hoạt động.  

- Tuy nhiên, mọi phương án đều có điểm chung là bốn bước tổ chức thực hiện một 
hoạt động học (theo Công văn số 5555/BGDĐT-GDTrH) và tại mỗi bước luôn có 
sự tương tác giữa GV và HS. 

 

Hình 1: Bốn bước tổ chức thực hiện hoạt động 

#1: Chuyển giao 
nhiệm vụ

• Trình bày cụ thể 
nội dung nhiệm 
vụ.

• Cách mà GV 
giao nhiệm vụ 
cho HS (đọc/ 
nghe/ nhìn/ làm) 
với thiết bị dạy 
học/ học liệu cụ 
thể.

#2: Thực hiện 
nhiệm vụ

• Liệt kê hành 
động cụ thể mà 
HS phải thực 
hiện (đọc/ nghe/ 
nhìn/ làm).

• Quan sát, dự kiến 
những khó khăn 
mà HS có thể 
gặp phải kèm 
theo biện pháp 
hỗ trợ; phát hiện.

#3: Báo cáo và 
thảo luận

• Trình bày cụ thể 
“ý đồ” lựa chọn 
HS/ nhóm báo 
cáo

• Xử lí kết quả 
thực hiện nhiệm 
vụ của HS, đặt ra 
các thảo luận đòi 
hỏi HS phải huy 
động các thao tác 
tư duy ở bậc cao 
hơn.

#4: Kết luận, nhận 
định

• Phân tích kết quả 
thực hiện nhiệm 
vụ; đối chiếu với 
mục “Sản 
phẩm”; đánh giá 
các mức độ hoàn 
thành.

• Chốt lại phần 
thảo luận; làm rõ 
vấn đề cần giải 
quyết và nhiệm 
vụ tiếp theo.
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Video dưới đây phân tích cụ thể từng bước nêu trên trong khi tổ chức thực hiện hoạt 
động (tham khảo thêm gợi ý về cách xác định mục tiêu bài học và tiến trình dạy học 
trong các video 3, 4, 5 tại Phụ lục 2). 

 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/unyfiCTGxs8 

Ví dụ về thiết kế hoạt động: 

https://youtu.be/-5ObjEve-u8 

 

3. Tổ chức dạy học trực tuyến 

Tuỳ vào từng nội dung bài học, GV có thể linh hoạt sử dụng kế hoạch bài dạy theo 
nhiều cách khác nhau khi thực hiện. Tuy nhiên, với mục tiêu giảm thời lượng kết nối 
trực tuyến thời gian thực, đồng thời tăng thời lượng làm việc tự chủ của HS. 

Đối với hình thức trực tuyến, GV cần lưu ý thêm rằng sự tương tác của GV và HS 
trong bốn bước tổ chức thực hiện hoạt động (xem Hình 1) cần được xem xét rộng hơn 
để xây dựng và thực hiện kế hoạch bài dạy trực tuyến phù hợp. Cụ thể là, thay vì chỉ 
tương tác trực tiếp và theo thời gian thực (xem Hình 2), khi dạy học trực tuyến, GV và 
HS có thể: (i) tương tác trực tiếp thời gian thực qua phần mềm; (ii) tương tác gián tiếp 
qua hệ thống dạy học trực tuyến (sau đây viết tắt là LMS – Learning Management 
System) và qua học liệu mà GV lựa chọn hoặc tự xây dựng để giao cho HS. Do đó, 
khoảng thời gian và thời điểm tương tác sẽ linh hoạt hơn (xem Hình 3), thời lượng kết nối 
trực tiếp thời gian thực qua phần mềm sẽ giảm đi mà vẫn đảm bảo được tiến trình dạy học 
tổng thể. 

 
Hình 2: Mốc thời gian 4 bước tổ chức dạy học trực tiếp 

Chuyển 
giao 

nhiệm vụ

Thực 
hiện 

nhiệm vụ

Báo cáo, 
thảo luận

Kết luận, 
nhận 
định
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Hình 3: Mốc thời gian tổ chức dạy học trực tuyến 

Hình 2 và Hình 3 cho ta một so sánh trực quan về mối liên hệ giữa hai hình thức 
tổ chức dạy học trực tiếp và trực tuyến. Bảng dưới đây là những gợi ý cụ thể để GV tổ 
chức thực hiện: 

 Hình thức Gợi ý thực hiện 

Bước 1: 

GV 
chuyển 
giao 
nhiệm vụ 

Bước 2: 

HS thực 
hiện 
nhiệm vụ 
học tập: 
nghe 
giảng; 
đọc SGK; 
làm bài 
tập; thực 
hành 

Dạy học trực tiếp: GV giảng bài, 
giao nhiệm vụ; HS nghe giảng, 
đọc SGK, thực hiện nhiệm vụ 
trong giờ học trên lớp (Ví dụ về 
thời lượng khoảng 15-20 phút). 

GV chuẩn bị, giảng bài trực tiếp; 
giao nhiệm vụ, giám sát, hỗ trợ HS 
thực hiện nhiệm vụ; nhận xét, 
đánh giá (trực tiếp với HS) trong 
quá trình HS thực hiện nhiệm vụ 

Dạy học trực tuyến: HS được 
giao tự thực hiện (nghe giảng qua 
video bài giảng; đọc SGK, trả lời 
câu hỏi) trước khi kết nối vào lớp 
học trực tuyến theo thời gian thực; 
nộp kết quả học tập theo yêu cầu 
của GV (qua LMS hoặc công cụ 
thay thế). 

Thời gian cần thiết để thực hiện 
nhiệm vụ phù hợp với nội dung 
bài học; HS được chủ động về 
thời điểm thực hiện (Ví dụ: Xem 
video bải giảng, trả lời câu hỏi cần 
khoảng 15-20 phút nhưng giao 
cho HS chủ động chọn thời điểm 
thực hiện) 

- GV chuẩn bị, ghi hình bài giảng 
(hoặc sử dụng video bài giảng có 
sẵn hoặc hướng dẫn HS xem video 
bài giảng trên truyền hình), giao 
nhiệm vụ cho HS bằng hình thức 
phù hợp (qua LMS hoặc công cụ 
thay thế); nhận xét, đánh giá kết 
quả HS thực hiện nhiệm vụ do HS 
nộp cho GV (qua LMS hoặc công 
cụ thay thế) 

Chuyển giao nhiệm vụ

Thực hiện nhiệm 
vụ

Báo cáo, thảo luận

Kết luận, nhận định
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Bước 3: 

HS báo 
cáo, thảo 
luận về 
kết quả 
học tập. 

Bước 4: 

GV nhận 
xét, đánh 
giá, 
"chốt" 
kiến thức, 
kĩ năng 

- Dạy học trực tiếp: GV tổ chức 
thực hiện ngay trong không gian 
lớp học (Sử dụng thời gian còn lại 
của bài học) 

- GV tổng hợp kết quả học tập (do 
HS thực hiện ngay tại lớp trước 
đó); tổ chức cho HS báo cáo, thảo 
luận; nhận xét, đánh giá, "chốt" 
kiến thức, kĩ năng; hướng dẫn HS 
vận dụng, giao nhiệm vụ học tập 
cho bài học tiếp theo 

- Dạy học trực tuyến: GV tổ 
chức lớp học kết nối trực tiếp để 
thực hiện trong không gian "lớp 
học ảo" (Thời gian thực hiện 
tương đương với thời gian sử 
dụng khi dạy học trực tiếp) 

- GV tổng hợp kết quả học tập (do 
HS gửi qua LMS hoặc công cụ 
thay thế trước đó); tổ chức cho HS 
báo cáo, thảo luận; nhận xét, đánh 
giá, "chốt" kiến thức, kĩ năng; 
hướng dẫn HS vận dụng, giao 
nhiệm vụ học tập cho bài học tiếp 
theo 

 

Ví dụ: Với những phân tích trên đây, GV có thể tổ chức dạy học trực tuyến cho 
mỗi bài học theo 3 giai đoạn như sau: 

– Giai đoạn 1 (Trước khi kết nối trực tiếp): Giao nhiệm vụ trên LMS hoặc công cụ 
thay thế 

§ GV chuẩn bị câu hỏi/ yêu cầu để giao nhiệm vụ cho HS tự đọc SGK (chỉ dẫn cụ 
thể khai thác nội dung, ngữ liệu, hình ảnh nào trong SGK) hoặc video bài giảng 
(do GV tự thực hiện hoặc video có sẵn) để trả lời câu hỏi/ thực hiện yêu cầu của 
GV.  

§ HS nộp kết quả (sản phẩm học tập) thực hiện cho GV qua mạng (LMS hoặc công 
cụ thay thế).  

§ GV tổng hợp kết quả của HS để chuẩn bị cho hoạt động thảo luận khi chuyển 
sang giai đoạn kết nối trực tiếp. 

– Giai đoạn 2 (Kết nối trực tiếp): Báo cáo, thảo luận về kết quả thực hiện nhiệm 
vụ ở giai đoạn 1 và hình thành kiến thức, kĩ năng 

§ GV và HS kết nối qua phần mềm tổ chức dạy học trực tuyến trực tiếp (như 
Zoom, Google Meet, Microsoft Teams, ...). 
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§ GV tổ chức cho HS báo cáo, thảo luận. GV chọn một số HS có kết quả ở Giai 
đoạn 1 cần đưa ra để thảo luận. GV kết luận và chốt lại các kết quả tốt/ chưa tốt/ 
chưa hoàn thiện. Từ đó, GV tổ chức hoạt động tiếp nối, giúp HS nắm chắc kiến 
thức/ kĩ năng cốt lõi cần dạy trong bài. 

– Giai đoạn 3 (Sau khi kết nối trực tiếp): Vận dụng 

§ Kết thúc Giai đoạn 2, GV giao cho HS hệ thống câu hỏi/ bài tập để luyện tập; HS 
tự chủ thực hiện và nộp bài làm qua LMS (hoặc các công cụ thay thế) mà nhà 
trường có thể tiếp cận. 

§ GV chấm/ đánh giá bài làm cho HS; tổng hợp lại những điểm cần lưu ý từ kết 
quả thực hiện nhiệm vụ của HS và xây dựng tư liệu hướng dẫn/ chữa bài tập 
(video hoặc tài liệu thay thế phù hợp). 

Lưu ý về sử dụng sơ đồ: 

§ Đối với bài học trang bị kiến thức mới thì: Ở Giai đoạn 1, GV giao cho HS đọc 
SGK hoặc xem video bài giảng; ở Giai đoạn 2, GV tổ chức cho HS hoạt động 
hình thành kiến thức mới và luyện tập; ở Giai đoạn 3, HS tự chủ thực hiện hoạt 
động vận dụng. 

§ Đối với bài học ôn/luyện tập thì: Ở Giai đoạn 1, GV giao cho HS một hệ thống 
câu hỏi/ bài tập để thực hiện trước; ở Giai đoạn 2, GV chữa bài tập cho HS; ở 
Giai đoạn 3, GV giao thêm một số bài tập luyện tập hoặc/và vận dụng khác. 

§ Giai đoạn 3 là giai đoạn do HS được giao tự làm việc ở nhà (tương ứng với hoạt 
động vận dụng ở nhà). Thời lượng của kế hoạch bài dạy được tính cho Giai đoạn 
1 và Giai đoạn 2. 

Khi xây dựng kế hoạch bài dạy trực tuyến để tổ chức theo 3 giai đoạn như trên, 
nếu có sự chuẩn bị tốt cho Giai đoạn 1 và Giai đoạn 3 thì sự hiệu quả của Giai đoạn 
2 nói riêng và của tiến trình dạy học nói chung sẽ được duy trì trong khi thời lượng 
kết nối trực tiếp sẽ giảm. Điều đó sẽ mang lại nhiều lợi ích về sức khoẻ cho HS, GV 
và về lâu dài sẽ tác động tích cực đến chất lượng dạy học nói chung.  

Ngoài ra, cán bộ quản lí và GV có thể tham khảo thêm về quản lí và tổ chức dạy 
học trực tuyến trong cơ sở giáo dục phổ thông trong Thông tư số 09/2021/TT-BGDĐT 
ngày 30 tháng 03 năm 2021 của Bộ Giáo dục và Đào tạo.   
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PHẦN	2:	THỰC	HIỆN	DẠY	HỌC	TRỰC	TUYẾN	

I. Bước 1: Chuẩn bị dạy học trực tuyến 

1. Biên soạn kế hoạch bài dạy và xây dựng tư liệu dạy học 

So với việc dạy học trên lớp, việc biên soạn kế hoạch bài dạy khi thực hiện dạy 
học trực tuyến đòi hỏi một cách tiếp cận mới để đạt hiệu quả: 

 

• Chẳng hạn, tăng cường chỉ dẫn để học sinh sử dụng có hiệu quả SGK và 
môi trường xung quanh HS tại gia đình (xem mục III)

Tăng cường đổi mới về phương pháp dạy học, biên soạn tiến trình dạy học 
phù hợp

• Chẳng hạn, chuyển thể một số kiến thức cốt lõi của bài học thành 
PowerPoint; dùng điện thoại hoặc phần mềm quay màn hình máy tính để 
ghi hình trước một số nội dung cần giảng (tham khảo công cụ tại Phụ lục 
1); ghi chú lại những chỉ dẫn cần thiết cho HS.

Sưu tầm hoặc xây dựng tư liệu dạy học phù hợp với bài học

• Mục đích: (1) đánh giá thái độ học tập của HS có nghiêm túc hay không 
(nội dung hỏi nằm trong video bài giảng, SGK và tài liệu mà GV đã giao 
nhiệm vụ); (2) kiểm tra mức độ hiểu bài của HS; (3) tích luỹ điểm số để 
đánh giá quá trình.

• Ví dụ, đối với mỗi buổi học, biên soạn một số câu hỏi trắc nghiệm để kiểm 
tra kiến thức liên quan; sử dụng các phần mềm online để soạn nội dung 
kiểm tra, đánh giá và gửi yêu cầu cho HS.

Có phương án đánh giá trong quá trình và sau mỗi bài học 

• Chẳng hạn, hướng dẫn học sinh làm bài vào vở, chụp kết quả bài làm và 
nộp bài (qua LMS, Zalo, Email hoặc những công cụ thay thế khác mà nhà 
trường đang sử dụng).

Giao cho HS một số bài tập tự luận để luyện tập, vận dụng và củng cố kiến 
thức sau mỗi bài học
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2. Lựa chọn nền tảng để tổ chức dạy học 

 
II. Bước 2: Tổ chức tiến trình dạy học trực tuyến 

1. Trước khi kết nối trực tiếp 

GV giao nhiệm vụ cho HS trên LMS hoặc gửi đường link bài học cho HS thông 
qua công cụ mạng xã hội (Zalo, Facebook, ...) để HS có thể thực hiện trước. 

2. Kết nối trực tiếp 

GV và HS kết nối qua nền tảng truyền tải hình ảnh thời gian thực (Microsoft 
Teams, Zoom, Google Meet, ...) để bắt đầu thực hiện tiến trình dạy học.  

Về cơ bản, việc tổ chức thực hiện giai đoạn này có thể tiến hành như đã gợi ý ở 
trên. Tuy nhiên, tuỳ vào nội dung bài học và thời lượng, GV có thể linh hoạt điều chỉnh 

• GV có thể sử dụng các nền tảng dạy học trực tuyến khác nhau dựa theo điều 
kiện và ý đồ dạy học của mình (Video: Youtube, Google Drive,...; Trắc 
nghiệm: Google Forms, Kahoot,...; ...).

• Công cụ phải đơn giản đối với HS, nhưng vẫn hỗ trợ GV kiểm soát được quá 
trình học tập.

Lựa chọn công cụ phù hợp cho từng định dạng tư liệu dạy học

• Hạn chế việc đặt các tư liệu dạy học một cách rời rạc, dẫn đến khó tổ chức 
dạy học hoặc tổ chức không hiệu quả.

• Giúp thể hiện được tiến trình dạy học theo ý đồ sư phạm của GV và để HS 
có thể dễ dàng tiếp cận, đáp ứng được sơ đồ dạy học trực tuyến 3 giai đoạn 
đã trình bày ở mục III.

Khuyến khích sử dụng các nền tảng cho phép kết nối/hỗ trợ nhiều loại tư liệu 
dạy học số hoá

• Đảm bảo cho việc liên lạc thông suốt, chuẩn bị cho việc tổ chức tiến trình 
dạy học qua mạng. 

• Ví dụ: lập nhóm Zalo cho từng lớp; thống nhất với phụ huynh về khung giờ 
nhất định để học sinh được sử dụng thiết bị và phối hợp giám sát HS.

Lựa chọn công cụ/mạng xã hội để tổ chức nhóm thảo luận và giao tiếp với phụ 
huynh, với HS
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cho phù hợp với thực tế. Chẳng hạn, sau khi báo cáo, thảo luận về kết quả thực hiện 
nhiệm vụ đã giao, GV có thể dành một khoảng thời gian (không quá dài) của đầu buổi 
học để giảng bài, nhấn mạnh nội dung cốt lõi, hướng dẫn HS xem video và sử dụng 
SGK, ... để thực hiện nhiệm vụ tiếp theo. 

Sau khi được hướng dẫn và nhận nhiệm vụ, HS tự chủ thực hiện với tư liệu đã 
được cung cấp. GV “quan sát”, hỗ trợ:  

- nhận cuộc gọi qua Zalo của HS để trợ giúp (đối với HS chủ động); 
- gọi kiểm tra xác suất việc thực hiện hoạt động tự chủ của HS (thường là những 

HS chưa thực sự tích cực, hoặc xoay vòng kiểm tra, …); 
- xem thông tin phản hồi kết quả học tập của HS qua bài trắc nghiệm nhanh kiến 

thức (nếu có). 

Qua đó, GV nắm được thông tin, tổng hợp lại những điểm mấu chốt cần thảo luận 
và kết luận cho HS ở cuối giờ học. 

Tiếp tục dùng nền tảng truyền tải hình ảnh thời gian thực (Microsoft Teams, Zoom, 
Google Meet) để kết nối lại lớp học. Tổ chức hoạt động: Báo cáo và thảo luận; đánh 
giá và chốt kiến thức; giao nhiệm vụ về nhà. 

Thực hiện tiến trình dạy học qua mạng đòi hỏi GV cần có sự trau đồi về kĩ năng 
CNTT, nhất là ở giai đoạn đầu áp dụng. Kết quả học tập của HS phụ thuộc rất nhiều 
vào cách thức tổ chức tiến trình dạy học. Mà tiến trình đó có mối quan hệ với kĩ năng 
sử dụng CNTT của từng GV. 

III. Bước 3: Kiểm tra, đánh giá, ôn tập trực tuyến 

1. Lựa chọn công cụ 

Sau mỗi bài học hoặc một nhóm bài học, GV có thể tổ chức kiểm tra, ôn luyện qua 
mạng thông qua các phần mềm hoặc công cụ trực tuyến như Google Forms, Kahoot, 
Microsoft Forms,… Trong đó có những công cụ thích hợp để tổ chức kiểm tra, đánh 
giá; có công cụ lại thích hợp để tổ chức cho HS làm trắc nghiệm trên nền tảng trò chơi. 
Như vậy, việc lựa chọn công cụ nào tuỳ thuộc vào mục đích sử dụng của GV cũng như 
điều kiện thực tế của HS.  
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Để chi tiết hơn về các công cụ này, mời các thầy cô tham khảo mục Lựa chọn và sử 
dụng công cụ hỗ trợ đánh giá thường xuyên.   

2. Tổ chức kiểm tra, ôn luyện qua mạng  

Mặc dù có thể được tổ chức trên nhiều công cụ khác nhau, nhưng nhìn chung 
quá trình kiểm tra, ôn luyện qua mạng đều trải qua quy trình sau:  

 
Hình 4: Quy trình tổ chức kiểm tra trực tuyến 
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PHỤ	LỤC	1:	MỘT	SỐ	KĨ	NĂNG	SỬ	DỤNG	CNTT		
TRONG	DẠY	HỌC	TRỰC	TUYẾN	(KÈM	THEO	12	VIDEO)	

I. Lựa chọn và sử dụng phần mềm để chuẩn bị dữ liệu dạy học. 

1. Thiết kế bài trình chiếu PowerPoint 

 
1.1. Lựa chọn một template cho bài trình chiếu  

Việc lựa chọn 1 template cho bài trình chiếu ngay từ khi bắt đầu thiết kế PowerPoint 
giúp các thầy cô không mất quá nhiều thời gian trong việc thiết kế từng Slide, cũng như 
đảm bảo toàn bộ bài trình chiếu có một hình thức đồng bộ giữa các Slide. Hai cách lựa 
chọn template cho bài trình chiếu:   

• Nhấn chọn tab Design > Theme và lựa chọn mẫu có sẵn.  
• Tìm kiếm và khai thác các nguồn template có sẵn của PowerPoint, Google Slides 

hoặc từ một số website chia sẻ miễn phí (xem chi tiết tại mục VI.3.Template bài 
trình chiếu PowerPoint.) 

1.2. Thêm nội dung và chỉnh sửa hình thức cho từng slide  

 

1. Lựa chọn một 
mẫu Template cho 

bài trình chiếu

2. Thêm nội dung và 
chỉnh sửa hình thức 

cho mỗi slide 

3. Thiết lập AnimaHon 
cho mỗi slide và 

TransiHon giữa các slide

Lựa chọn nội dung trình bày trên mỗi trang slide một cách ngắn gọn, xúc ?ch. 

Các nội dung nên được phân cấp thông In thành các ý, rõ chính, phụ để HS dễ dàng 
Iếp nhận thông In. 

Khuyến khích cách trình bày nội dung dưới dạng infographic hoặc dưới dạng các 
mẫu SmartArt có sẵn trong PowerPoint
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1. 3. Thiết lập Animation cho mỗi slide và Transition giữa các slide 

Các hiệu ứng chuyển động của đối tượng (Animation) và hiệu ứng chuyển cảnh giữa 
các slide (Transition) giúp bài trình chiếu của các thầy cô trở lên sinh động và hấp dẫn 
hơn, thu hút sự chú ý của HS vào các nội dung mà GV muốn nhấn mạnh. Tuy nhiên 
cũng không nên lạm dụng Animation và Transition khiến cho bài trình chiếu trở lên 
hỗn loạn và khiến HS phân tâm khỏi nội dung của bài học.  

2. Quay video bài giảng bằng phần mềm Zoom 

Để ghi hình các bài giảng sao cho vừa thể hiện nội dung trình chiếu, vừa hiển thị hình 
ảnh của GV, các thầy cô cần:  

– Ghi hình phần trình chiếu: tính năng Ghi hình cuộc họp (Record) của Zoom.  

– Ghi hình GV: webcam của laptop/ máy vi tính.   

Tóm tắt các bước thực hiện: 

 
Xem chi tiết video hướng dẫn: 

 

 
(Scan để truy cập) 

Youtube Link: 
https://youtu.be/ZlrjML7m3b0 

 

 

Bước 1: Bắt đầu một cuộc họp trong Zoom, bật Start Video để chia sẻ hình ảnh từ 
webcam của bạn.

Bước 2: Sử dụng ?nh năng Share Screen để chia sẻ hình ảnh từ file trình chiếu.

Bước 3: Điều chỉnh vị trí và kích thước phần hình ảnh của bạn và bắt đầu ghi hình 
bằng ?nh năng Record.  

Bước 4: Kết thúc cuộc họp để ngừng ghi hình. Video sẽ được convert và lưu lại trên 
máy ?nh của bạn. 
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II. Lựa chọn và sử dụng nền tảng tương tác và lưu trữ nội dung dạy học, kết quả 
thực hiện nhiệm vụ của HS 

1. Hướng dẫn sử dụng ứng dụng Zoom 
Để sử dụng Zoom, GV cần cài đặt/đăng nhập ứng dụng trên máy tính/điện thoại. 
Tóm tắt một số chức năng của ứng dụng Zoom: 

 
Bước 1: Chọn Home chọn New 
meeting. 
Bước 2: Các thao tác chính: 

(1) Hiển thị thông tin cuộc họp 

(2) Hiển thị chế độ phóng to màn hình 

(3) Mute: Bật/Tắt mic của thầy cô 

(4) Stop Video: Bật/Tắt hình ảnh 
camera của thầy cô 

(5) Invite: Mời thêm người khác tham gia cuộc họp bằng thư điện tử (email) hoặc 
bằng danh sách liên hệ đã lưu. 

(6) Manage Participants: Hiển thị số lượng và danh sách tất cả các thành viên tham gia. 

Lưu ý: Nếu là chủ cuộc họp (Meeting Host) chúng ta có thể bật/ tắt âm thanh hay 
màn hình thành viên tham gia cuộc họp. Chúng ta cũng có thể cho thành viên đó 
rời đi, đổi tên, nhắn tin hoặc đưa thành viên đó lên là chủ cuộc họp. 

(7) Share Screen: Chia sẻ màn hình của cá nhân. Để kết thúc chức năng chia sẻ 
màn hình chọn “Stop Sharing”. 

(8) Chat: Trao đổi thông tin (chat) với một/ tất cả thành viên đang tham gia cuộc họp. 

(9) Record: Ghi lại cuộc họp. 

(10) Reactions: Là các biểu tượng cảm xúc vỗ tay hoặc thích. 

(11) End Meeting: Kết thúc cuộc họp.  

 
Bước 1: Chọn Home > Chọn Join để tham gia cuộc họp. 

Chức năng tạo lớp học/cuộc họp 

Chức năng tham gia cuộc họp 
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Bước 2: Hộp thoại “Join Meeting” sẽ hiển thị lên, điền ID cuộc họp hoặc tên liên 
kết cá nhân được chia sẻ cho thầy cô.  
Bước 3: Chọn “Join” để tham gia cuộc họp. 

 
Bước 1: Chọn Home > chọn Schedule. 
Bước 2: Hộp thoại Schedule meeting hiển thị, hoàn thành các mục sau đây: 

Topic (Chủ đề): Nhập một chủ đề hoặc tên cho cuộc họp của thầy cô. 
Start (Bắt đầu): Chọn thời gian cho cuộc họp của thầy cô.  
Duration (Thời lượng): Chọn thời lượng gần đúng của cuộc họp. Điều này chỉ 
dành cho mục đích lập kế hoạch. Cuộc họp sẽ không kết thúc sau khoảng thời gian 
này. 
Time Zone (Múi giờ): Theo mặc định, Zoom sẽ sử dụng múi giờ trên máy tính 
của thầy cô. Nhấp vào menu thả xuống để chọn múi giờ khác. 
Recurring meeting (Cuộc họp định kỳ): Chọn nếu thầy cô muốn một cuộc họp 
định kỳ (ID cuộc họp sẽ giữ nguyên cho mỗi phiên).  
Participants (Người tham gia): Chọn bật/tắt nếu thầy cô muốn bật hoặc tắt video 
của người tham gia khi tham gia cuộc họp. Ngay cả khi thầy cô tắt, những người 
tham gia sẽ có tùy chọn để bắt đầu video của họ. 
Âm thanh (audio): Cho phép người dùng chỉ gọi qua điện thoại, chỉ gọi qua máy 
tính hoặc cả hai. 
Lịch: Chọn một dịch vụ lịch để thêm cuộc họp và gửi lời mời đến những người 
tham gia. 
Advanced options (Tùy chọn nâng cao): Nhấp vào mũi tên để xem các tùy chọn cuộc 
họp bổ sung. 

Bước 3: Chọn Schedule để hoàn tất tạo lịch. 

 
Bước 1: Chọn “New chat or channel” > chọn “Create a channel” 

Bước 2: Hộp thoại Create a channel hiển thị, đặt tên dưới mục “Channel Name” 
và mời thành viên vào tham gia dưới mục “Invite members”. 

Bước 3: Chọn cài đặt riêng tư cho kênh. 

• Riêng tư: chỉ những tài khoản được mời mới tham gia vào kênh được. 
• Công cộng: Bất kỳ ai trong tổ chức cũng có thể tham gia. 

Chức năng lên lịch cuộc họp 

Chức năng tạo kênh 
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Bước 4: Chọn “Create Channel” để hoàn tất. 

 
Chọn Meeting → chọn Recorded → chọn tên file ghi: 

 
Open: Mở thư mục chứa các tập tin đã ghi lại. 
Play: Phát video file ghi bằng trình phát phương tiện mặc định của máy tính. 
Play Audio: Phát âm thanh cuộc họp đã ghi bằng trình phát phương tiện mặc định 
của máy tính. 
Delete: Xóa file ghi âm. 
 

Xem chi tiết video hướng dẫn: 

 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/TngpzLFlbco 
 

2. Hướng dẫn sử dụng Google Meet trong dạy học online 

Bước 1: Đăng nhập vào hệ thống thông qua đường link: https://meet.google.com/ 
Hoặc thầy cô đăng nhập vào Gmail thông thường, sau đó chọn Google Meet 

 

Làm việc với file ghi 
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Bước 2: Nhấn chọn Tham gia hoặc bắt đầu 1 cuộc họp (Join or start a meeting) 

 
Nếu trên lịch có những lịch học/ họp đã được lên lịch trước thì thầy cô sẽ nhìn thấy 
danh sách lớp học/ họp ở ngay bên dưới nút Tham gia... 

Bước 3: Đặt tên cho buổi học/họp và chọn Tiếp tục (Continue) 

 
Lưu ý: Không đặt tên lớp bằng tiếng Việt có dấu. 

 
Bước 4: Chọn More Option và Cài đặt để cấu hình Camera và Micro nếu cần 
thiết (thường không cần điều chỉnh vì hệ thống tự nhận biết). Sau khi thiết lập 
song chọn Tham gia ngay 
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Bước 5: Mời các thành viên tham gia họp bằng cách chép và chuyển (email) cho họ 
liên kết (URL) của cuộc họp/ lớp học 

Nếu HS hoặc các thành viên đều dùng chung 1 loại email của công ty hoặc nhà trường 
và được phân nhóm thì thầy cô có thể sử dụng email nhóm để mời nhanh các thành viên 
vào nhóm. Ví dụ mời tất cả HS lớp 6A vào lớp và nhóm HS này đã được tạo trên hệ 
thống Email thì thầy cô chỉ cần mời tài khoản email nhóm đó vào lớp thì tất cả HS sẽ 
vào lớp. 

 
Hoặc chọn Thêm người để mời, với cách mời này chúng ta có thể thêm từng người 
hoặc Copy và Paste danh sách email của nhiều người (tối đa một lần chép/ dán là 30 email). 

Bước 6: Trình bày trong lớp học, chọn Trình bày ngay bây giờ, chọn Toàn bộ màn 
hình hoặc Một cửa sổ và mở file để trình chiếu  

 
Toàn bộ màn hình của bạn: Với lựa chọn này thì HS có thể quan sát được tất cả những 
gì đang diễn ra trên màn hình của thầy cô. 
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Một cửa sổ: HS chỉ có thể quan sát được những gì đang diễn ra trên cửa sổ mà thầy cô 
lựa chọn 

Bước 7: Ghi hình cuộc họp chọn nút Tùy chọn và chọn Ghi lại cuộc họp để ghi (file 
video sẽ được lưu trên Google Drive , Khi muốn kết thúc ghi hình chọn Tùy chọn và 
chọn Dừng ghi. 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

 
Youtube Link: 

https://youtu.be/nxwUw4uD_t8 
 

3. Hướng dẫn sử dụng Google Classroom 

Với Google Classroom các GV có thể: 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
Để sử dụng Classroom, GV cần: 
- Đăng kí hoặc đang sử dụng tài khoản Google. 
- Máy tính cá nhân có kết nối internet. Ngoài ra, GV có thể tải ứng dụng từ Google 
Play Store hoặc App Store về điện thoại hoặc máy tính bảng. 
Hướng dẫn sử dụng Google Classroom để dạy học trực tuyến 

Quản lí học tập miễn phí 

Sản phẩm chuyên cho dạy học trực tuyến; hoàn toàn miễn phí, tốc độ cao và đặt 
biệt an toàn, bảo mật. 

Làm việc mọi lúc mọi nơi trên mọi thiết bị 
GV và HS có thể đăng nhập từ bất kỳ máy tính hoặc thiết bị di động nào để truy 
cập các bài tập, tài liệu khoá học và đóng góp phản hồi. 

 
 

Tiết kiệm và linh động về thời gian 
GV hoàn toàn có thể quản lí thời gian giao, nộp bài của HS, đưa ra lời nhận xét 
trực tiếp.  
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Bước 1: Truy cập Classroom.google.com 

Bước 2: Đăng nhập vào Classroom, sau đó click chuốt vào nút  

Bước 3: Chọn nút Tạo lớp học và điền các thông tin cần thiết. 

Bước 4: Click chuột vào nút Tạo. 

 

Bước 1: Trên thẻ lớp học, click chuột vào nút   

Bước 2: Thực hiện thay đổi thông tin cần thiết. 

Bước 3: Click vào nút Lưu để hoàn tất. 

  

 
Sau khi vào không gian Google Classroom, ta thực hiện: 

Bước 1: Chọn một lớp học cụ thể sau đó click chọn thanh Bài tập trên lớp. 

Bước 2: Nhấn vào nút  

 

  

Tạo lớp học trên ứng dụng/trang web Classroom 1 

Chỉnh sửa và sao chép thông tin lớp học 2 

Đăng tài liệu lên lớp học 3 
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Sau khi vào không gian Google Classroom, ta thực hiện một trong các cách sau: 

Cách 1: Mời học viên bằng cách thêm Gmail. 

Bước 1: Trên thanh công cụ, chọn tab Mọi người . 

Bước 2: Click chọn  

   
Cách 2: Mời học viên bằng cách gửi Mã lớp học 

Bước 1: Chọn lớp học. 

Bước 2: Sao chép mã lớp học gửi cho học viên. 

      

 
Bước 1: Trong lớp học cụ thể, chọn thanh Bảng tin. 

Bước 2: Nhập thông tin muốn đăng tải vào ô nội dung, chọn thêm tệp đính kèm, 
đường dẫn, video tử Youtobe. 

Bước 3: Click vào nút Đăng (hoặc Lên lịch hoặc Lưu bản nháp). 

Mời học viên tham gia lớp học 4 

Khuyến khích học viên trao đổi và tương tác 5 
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Bước 1: Đăng nhập vào Classroom. Chọn biếu tượng cài đặt. 

Bước 2: Trong mục Chung, chọn Bảng tin sau đó chọn cách tương tác mà HS có 
thể thực hiện. 

 

4. Hướng dẫn sử dụng Microsoft Teams 

Microsoft Teams là ứng dụng thuộc hệ sinh thái Microft 365 dành cho làm việc 
nhóm và dạy học trực tuyến, với nhiều tính năng như chat, video call, họp trực tuyến, 
chia sẻ tài nguyên,... giúp mọi người trong nhóm cộng tác với nhau dễ dàng hơn trên 
cùng một nền tảng. Teams có nhiều ưu điểm:  

• Miễn phí dành cho GV và HS tại các nhà trường và các cơ sở đào tạo.  

• Hợp trực tuyến, gọi điện và chat ở mọi nơi mọi lúc 

• Tổ chức, quản lí lớp học một cách hiệu quả 

• Lên lịch và theo dõi thời gian học tập cho lớp học 
• Dữ liệu được tập hợp và quản lí khoa học,  

Cấp quyền cho HS đăng bài và phản hồi 6 
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• Hỗ trợ tích hợp với hàng trăm ứng dụng khác: OneNote, Microsoft To Do, 
Quizlet, Kahoot, Miro,... 

• Khả năng bảo mật dữ liệu cao. 

 
Bước 1: Đăng nhập vào tài khoản Microsoft cá nhân 

- Nhấn Get the Windows app để tải phần mềm xuống máy tính. 

- Nhấn Use the web app instead để sử dụng phiên bản Microsoft Teams online. 

Bước 2: Nhập tài khoản Microsoft > Sign in để tiếp tục. 

Bước 3: Nhấn Sign Up For Teams để tiến hành thiết lập cho nhóm làm việc. Một 
trang web mới hiển thị để bạn lựa chọn. Tại đây nếu người dùng đã có nhóm làm 
việc thì nhấn Sign in, chưa có nhóm thì tiến hành thành lập nhóm, nhấn Sign Up 
For Free. 

Điền địa chỉ email cá nhân rồi nhấn Next để tiếp tục. 

Bước 4: Nhập đầy đủ thông tin tên bạn và tên công ty, sau đó nhấn Set Up 
Teams để tạo nhóm làm việc mới. 

- Kết quả chúng ta đã tạo nhóm làm việc trên Microsoft Teams thành công. Mỗi 
một nhóm làm việc sẽ có link nhóm. Người dùng gửi link nhóm này tới các thành 
viên khác. 

- Khi có người muốn tham gia vào nhóm làm việc thì bạn sẽ nhận được email, nhấn 
Accept để đồng ý. 

Bước 5: Các tính năng: 

- Activity: Hiển thị mọi thông báo liên quan tới bạn. 

- Chat: Nhắn tin với những thành viên khác. 

- Teams: Làm việc nhóm. 

- Call: Gọi điện cho các thành viên. 

- Files: Files tải lên và chia sẻ với mọi thành viên. 

Bước 6: Trong mục Teams sẽ có các biểu tượng hỗ trợ liên lạc nhóm, trong đó 
có biểu tượng Meet now để tổ chức cuộc họp trực tuyến dạng video.  

Tạo tài khoản Microsoft Teams 1 
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Bước 7: Mục Call để quản lý các cuộc gọi thoại tới bất kỳ thành viên nào.  

 
 

Bước 1: Nhấn vào biểu tượng share để lựa chọn chia sẻ màn hình. 

Bước 2: Lúc này hiển thị rất nhiều màn hình khác nhau và được Microsoft Teams 
chia thành từng nhóm cụ thể. Bạn chọn 1 màn hình để chia sẻ tới các HS.  

Bước 3: Lúc này màn hình mà bạn chọn chia sẻ đã được chuyển sang thiết bị của HS. 

Bước 4: Màn hình gọi video được chuyển xuống phía dưới để chúng ta vẫn có thể nhìn 
thấy được HS của mình. Các thầy cô thực hiện mọi thao tác trên màn hình thì các em 
HS đều nhìn thấy được. Để dừng chia sẻ nhấn biểu tượng share dấu x.  

Bước 5: Trong trường hợp bạn muốn mở trực tiếp slide PowerPoint trên Microsoft 
Teams để chia sẻ thì nhấn Browse rồi chọn Upload from my computer. 

Nếu chia sẻ slide kiểu này thì HS tham gia có thể tự ý di chuyển slide mà thầy cô 
không biết. Để hạn chế việc HS điều chỉnh trình chiếu slide, bạn nhấn vào biểu 
tượng mắt tại Stop presenting.  

 
 

Bước 1: Bắt đầu hoặc tham gia cuộc họp. 

Bước 2: Đi đến các điều khiển cuộc họp, rồi chọn Xem thêm hành động  bắt 
đầu ghi. 

Bước 3: Ngừng ghi cuộc họp 

Ngừng ghi: Ngừng bản ghi và bản ghi trực tiếp. 

Ngừng bản ghi: Chỉ dừng bản ghi trực tiếp. Quá trình ghi sẽ tiếp tục cho đến khi 
bạn chọn Dừng ghi. 

Bước 4: Xem lại bản ghi, chọn mở lại cuộc trò chuyện của lớp học, họp online. 

III. Lựa chọn và sử dụng công cụ hỗ trợ đánh giá thường xuyên bằng tự luận và 
trắc nghiệm 

1. Tổ chức kiểm tra, ôn luyện qua mạng bằng Google Forms 

Cách chia sẻ màn hình trên Microsoft Teams 2 

Cách ghi lại cuộc họp trên Microsoft Teams 3 
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Google Forms là công cụ tạo và quản lí biểu mẫu khảo sát, được phát triển bởi Google.  

1.1. Nhập đề kiểm tra vào hệ thống (Tạo biểu mẫu) 

Bước	1:	Truy cập địa chỉ https://forms.google.com/. Tại đây, để tạo biểu mẫu mới 
nhấn chọn ô “Trống” (hoặc Blank) 

 
Trong trường hợp bạn chưa đăng nhập trên trình duyệt, Google sẽ yêu cầu bạn đăng 
nhập bằng tài khoản Gmail.  

Bước	2:	Giao diện tạo biểu mẫu mới như sau: Trong đó:  

- Vùng màu đỏ: nơi nhập tên và 
thông tin mô tả biểu mẫu. 

- Vùng màu tím: các tùy chọn. 

- Vùng màu xanh lá: nơi công cụ 
thiết lập và cài đặt biểu mẫu. 

- Vùng màu xanh dương: nơi nhập 
các câu hỏi 

Bước	3: Tại đây, nhập vào các thông tin: 

- Tên biểu mẫu và mô tả biểu mẫu. 

- Nội dung câu hỏi và các phương án. Nhấn Enter để chuyển sang nhập phương án 
tiếp theo. Sau khi nhập xong một câu hỏi, nhấn nút thêm mới ở thanh công cụ bên 
phải để thêm câu hỏi tiếp theo. 

Bước	4: Tiến hành cài đặt cho biểu mẫu  

Sau khi hoàn tất việc thêm câu hỏi và chỉnh 
sửa, để tùy chỉnh biểu mẫu, ta chọn các biểu 
tượng ở trên cùng bên phải màn hình 
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(1): Tùy chỉnh màu sắc cho biểu mẫu  (2): Xem trước biểu mẫu 

(3): Cài đặt > Bài kiểm tra > Bật “Đặt bài kiểm tra” > Lưu 

(4): Gửi biểu mẫu cho HS 

(5): Tùy chọn như: nhân đôi biểu mẫu, xóa biểu mẫu, in biểu mẫu,... 

Lưu ý, khi bật 
Đặt làm bài kiểm 
tra, các câu hỏi sẽ 
xuất hiện tùy 
chọn đáp án và 
điểm, bạn nhấn 
vào Đáp án để 
cài đặt đáp án 
đúng và điểm cho 
các câu hỏi.  

1.2. Giao đề kiểm tra cho HS  

Nhấn vào Gửi phía trên góc phải màn hình để chia sẻ đề đến HS thông qua email hoặc 
đường link. 

1.3. Thu thập và thống kê kết quả 

- Ngay sau khi HS làm bài xong, để xem kết quả bài làm của HS, nhấn chọn Câu trả 
lời để xem kết quả dưới dạng biểu đồ. 

 

- Tại đây, kết quả được hiển thị  
- Để xem chi tiết và tải danh sách HS làm bài, nhấn chọn  
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Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/NqUDcX0k3VA 

 

2. Tổ chức kiểm tra, ôn luyện qua mạng bằng Microsoft Forms 

❶ Để sử dụng, truy cập vào địa chỉ 
forms.office.com và đăng nhập vào tài 
khoản Microsoft của bạn.  

❷ Lựa chọn Biểu mẫu mới hoặc Bài 
kiểm tra mới.  

❸ Nhập tên và mô tả 
cho Biểu mẫu mới 
hoặc Bài kiểm tra 
mới. 

 

❹ Chọn Thêm mới để bắt đầu thêm một câu hỏi hoặc một mục. Một số dạng câu 
hỏi thường dùng trong bài kiểm tra: lựa chọn, văn bản, xếp thứ tự, xếp loại,...  

 
Chú ý đặt đáp án và số điểm cho câu hỏi (nếu có). Bạn cũng có thể thiết lập các tuỳ 
chọn như nhiều câu trả lời, bắt buộc, tuỳ chọn sắp xếp ngẫu nhiên (các phương án),...  
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Đối với câu hỏi tự luận, lựa chọn dạng câu hỏi văn bản và thiết lập là câu trả lời dài. 

❺ Khi đã tạo xong các câu hỏi, nhấn vào dấu 
ba chấm bên cạnh nút Gửi, chọn Thiết đặt để 
đặt ra các tuỳ chọn đối với bài kiểm tra. Lưu ý 
tính năng sắp xếp ngẫu nhiên câu hỏi không sử 
dụng được với các bài kiểm tra có chứa các mục.  

 

❻ Nhấn chọn Chủ đề để thay đổi hình nền và 
màu sắc cho bài kiểm tra. Sau đó nhấn chọn 
Xem trước để xem thử bài kiểm tra của mình.  
 

❼ Tiếp tục nhấn chọn Gửi, copy liên kết/ tải 
mã QR để gửi cho HS hoặc chỉ định trực tiếp 
danh sách HS qua địa chỉ email.  

 

❽ Sau khi HS làm bài xong, nhấn chọn tab 
Phản hồi để thu thập và thống kê kết quả:  

• Kéo xuống phía dưới để xem số liệu và biểu 
đồ thống kê đối với từng câu hỏi 

• Nhấn chọn Xem lại câu trả lời để xem kết 
quả theo từng HS hoặc từng câu hỏi. 

• Nhấn chọn Mở trong Excel để tải tệp thống 
kê kết quả của tất cả HS. 
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TỔNG KẾT: Google Forms và Microsft Forms là hai công cụ tương đồng về các 
chức năng chính. Cả hai đều có giao diện tương đối đơn giản và thân thiện với người 
dùng. Khi so sánh với nhau, Google Forms và Microsoft Forms thể hiện những ưu 
điểm riêng như bảng dưới đây. Do vậy, việc lựa chọn công cụ nào tùy thuộc vào mục 
đích sử dụng của người dùng.  

Google Forms Microsoft Forms 

• Hỗ trợ dạng câu hỏi cho phép người 
trả lời tải tệp lên 

• Cho phép tổ chức một câu hỏi thành 
nhiều trang 

• Thêm được hình ảnh, video như một 
đối tượng rời trong biểu mẫu (không 
thuộc câu hỏi/ mục). 

• Thu thập được địa chỉ email của 
những người trả lời 

• Cung cấp thư viện mẫu với các biểu 
mẫu có sẵn 

• Dữ liệu được thu thập và thống kê qua 
Google Sheets. 

• Dễ dàng xem trước biểu mẫu với giao 
diện trên điện thoại và trên máy tính 

• Chia sẻ được thông qua QR code, dễ 
dàng nhúng vào OneNote Class 
Notebook. 

• Cho phép cài đặt thời gian bắt đầu và 
kết thúc, tự động tính toán thời gian 
trung bình hoàn thành biểu mẫu. 

• Cho phép khóa một số câu hỏi khi xáo 
trộn thứ tự. 

• Hỗ trợ công thức, kí hiệu toán học. 
• Nhập và xuất được dữ liệu từ tệp 

Excel.  

 

3. Tổ chức kiểm tra, ôn luyện qua mạng bằng Kahoot! 

Kahoot! là công cụ hỗ trợ học tập dựa trên nền tảng trò chơi với những câu hỏi trắc nghiệm. 
So với Google Forms và Microsoft Forms, Kahoot! thích hợp cho vừa học vừa chơi, 
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cách tạo đề trắc nghiệm cũng tương đối dễ dàng. Tuy nhiên hạn chế của Kahoot! là không 
hỗ trợ tạo các câu hỏi tự luận.   

3.1. Tạo tài khoản  

Bước	1: Truy cập vào https://kahoot.com, ở góc 
phải ta thấy các nút:  

- Nhấn vào Play nếu bạn muốn tham gia game. 

- Nhấn vào Login nếu bạn đã có tài khoản. 

- Nhấn vào Sign up để đăng kí tài khoản mới. 

Bước	2:	Để cài đặt ứng dụng Kahoot! cho các thiết bị như điện thoại, máy tính 
bảng,…truy cập kho ứng dụng trên thiết bị và tìm kiếm với từ khóa Kahoot! 

3.2. Nhập đề kiểm tra vào hệ thống (Tạo Kahoot) 

Bước 1: Trước hết, bấm vào nút Create > New Kahoot. 

Bước 2: Giao diện của Kahoot! lúc này có dạng như sau: 

 
- Vùng xanh lá: Bao gồm nút tạo câu hỏi mới (Add question), Chọn câu hỏi từ ngân 
hàng câu hỏi chia sẻ (Question bank), Nhập từ tệp trình chiếu PowerPoint, PDF, ..; 
Nhập từ tệp excel (Import spreadsheet – Có tệp tin mẫu để tải về và làm theo). 
- Vùng màu đỏ là khu vực nhập câu hỏi và các đáp án. 
- Vùng màu vàng: Tùy chọn thời gian làm cho câu hỏi, điểm số và loại câu hỏi. 

Bước	3: Nhấn vào nút Add question để thêm một câu hỏi mới và tiếp tục nhập nội 
dung. 
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Bước	4: Bạn cũng có bấm vào nút Import spreadsheet.  
- Chọn Download our template để tải tệp tin mẫu về và 
tiến hành điền thông tin các câu hỏi và đáp án đã chuẩn bị 
theo nội dung tệp tin mẫu. 
- Chọn Select file và chọn tệp danh sách câu hỏi chúng ta đã 
chỉnh sửa theo mẫu và bấm vào nút Upload để nhập các câu 
hỏi lên hệ thống. 
- Chọn Done để kết thúc. 

3.3. Tổ chức kiểm tra, ôn luyện 

a) Giáo viên/Quản lí 

Trong mục My Kahoots bạn sẽ thấy được danh sách các bộ đề như sau: 

 
Bấm vào nút Play > Host/Challenge. Trong đó: 

Host: Cho HS tham gia và làm bài trực tiếp với 
sự giám sát, điều khiển của GV. 

- Chúng ta bấm chọn Classic để chọn chế độ đơn. 
Cửa sổ quản lý hiện ra bao gồm link để tham gia 
mã PIN để gửi cho HS. 

- Sau khi HS tham gia đầy đủ > Khoá > Start để 
bắt đầu. 

Challenge: Cho phép HS tham gia tự do trong 1 
khoảng thời gian nhất định.  

- Chọn Create để tạo link chia sẻ > Copy URL 
và chia sẻ cho HS qua các công cụ trao đổi trực 
tuyến như Zalo, Messenger, Telegram,... 

b) Học sinh/Người dùng 
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❶ Sử dụng URL + Mã PIN 

- HS truy cập URL và nhập mã PIN vào ô Game PIN và nhấn Enter 
- Một hộp thoại sẽ hiện lên yêu cầu HS nhập tên để tham gia 
- HS sẽ chờ GV bắt đầu game và nhìn câu hỏi qua màn hình của GV sau đó chọn 

đáp án trên màn hình của mình 

❷ Sử dụng URL 

- HS truy cập URL chia sẻ của GV 
- HS nhập Họ và tên và bấm vào OK, go! để bắt đầu 

3.4. Thu thập và thống kê kết quả 

❶ Để xem danh sách phòng thi mà ta đã cho HS tham gia, bấm chọn Reports  

 
❷ Để xem thống kê tổng quát, bấm vào một phòng cụ thể.  

 
❸ Bấm vào mục Player để xem danh sách HS. 

❹ Bạn cũng có thể xem kết quả chi tiết của từng HS bằng cách nhấn chọn tên HS đó. 

❺ Bấm vào mục Questions để xem thống kê theo câu hỏi và chi tiết tỉ lệ đúng sai của 
từng câu hỏi. 
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Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/OUXeKG8i7NA 

IV. Thu thập và xử lí kết quả đánh giá quá trình 

1. Thu thập kết quả quá trình 

Trong quá trình dạy học, kiểm tra đánh giá HS, GV thu thập được những kết quả mà 
HS đạt được vào hồ sơ quản lí của mình.  

Ví dụ:  

 

 

2. Xử lí dữ liệu kết quả quá trình 

2.1. Tách riêng dữ liệu theo đơn vị (lớp, trường) 

Ví dụ: Tách riêng đơn vị lớp và trường ở bảng 
hình bên: 

Bước	1:	Chọn (bôi đen) cột muốn tách dữ liệu, 
chọn tab Data trên thanh Ribbon > Text to 
Columns. 
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Bước	2: Xuất hiện giao diện hộp thoại Convert Text to Columns Wizard. Ở đây bạn 
sẽ cần thực hiện 3 bước để có được cột nội dung muốn tách. Trước hết tại Original 
data type sẽ có 2 tùy chọn tách cột gồm: 

- Delimited: tiến hành tách cột với những kí tự ngăn cách ví dụ như tab, dấu gạch 
ngang, dấu phẩy, khoảng trắng... 

- Fixed with: tách cột theo chiều rộng của dữ liệu, ví dụ dữ liệu gồm 2 cột dù từng 
hàng có chiều dài khác nhau, nhưng chia đều chiều rộng thành 2 khoảng giống nhau. 

Trong bài sử dụng dấu phẩy để ngăn cách nội dung, nên chúng ta sẽ tích chọn vào 
Delimited, sau đó nhấn Next ở bên dưới.  

Bước	3: Hộp thoại Convert Text to Columns Wizard – Step 2 of 3 xuất hiện, các bạn 
chọn kí tự ngăn cách giữa các loại dữ liệu trong các ô vừa chọn. Ví dụ như các ô vừa 
chọn ở trên ngăn cách nhau bởi dấu cách, nên các bạn chọn Space. 

- Nếu kí tự ngăn cách là kí tự khác, các bạn chọn tùy chọn tương tự với kí tự được dùng 
để ngăn cách: 

• Tab: phím tab. 
• Semicolon: dấu chấm phẩy. 
• Comma: dấu phẩy. 

• Space: dấu cách. 
• Other: kí tự khác. 

- Sau khi chọn xong các bạn nhấn Next để tiếp tục. 

Bước 4: Trong hộp thoại Convert Text to Columns Wizard – Step 3 of 3 chọn 
General và nhấn Finish. 

Bước 5: Xuất hiện cảnh báo như hình dưới đây, các bạn nhấn OK để đồng ý. Kết quả 
là nội dung trong 1 cột của bảng Excel đã được tách thành 2 cột như hình dưới đây. 
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Cảnh báo Kết quả thu được 

2.2. Tách riêng tên và họ - tên đệm của từng HS 

Bước	1:	Sao chép toàn bộ cột họ và tên (cột B) 
sang cột mới (cột D). 

Bước	2: Bôi đen để chọn toàn bộ phần họ và tên 
trong cột D. 

Bước	 3: Nhấn Ctrl + H, nhập * (dấu sao và phím cách) vào ô Find What rồi 
nhấn Replace All. 

 
Sau đó, xuất hiện thông báo. Bạn chọn OK. 

Bước	4: Trong ô C3, nhập công thức: = LEFT(B3,LEN(B3)-LEN(D3)), sau đó thay 
ô B3 này bằng ô đầu tiên chứa họ và tên ban đầu, D3 là ô đầu tiên chứa tên vừa tách. 

Trong đó: 

• Left là hàm cắt chuỗi từ trái qua, cú pháp = LEFT(ô chứa chuỗi cần cắt từ trái qua, 
số kí tự sẽ cắt) 

• Len là hàm lấy độ dài của chuỗi, cú pháp = LEN(ô chứa chuỗi cần lấy độ dài) 

 
Bước	5: Kéo toàn bộ công thức từ ô C3 xuống hết các ô còn lại ta được bảng sau: 
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2.3. Sắp xếp danh sách theo thứ tự bảng chữ cái hoặc thứ tự điểm 

a) Sắp xếp danh sách theo thứ tự bảng chữ cái 

Bước	1: Chọn vùng mà bạn muốn sắp xếp. 

Bước	 2: Trên thanh công cụ bạn click vào “Tab 
Data” và chọn đến lệnh “Sort” hoặc lệnh “A-Z”. 

Bước	3:	Một cửa sổ mới hiện ra, có 2 sự lựa chọn: 

• Expand the selection: Mở rộng sự lựa chọn 
• Continue with the current selection: Tiếp tục với lựa chọn hiện tại 

Sau đó nhấn chọn Sort. 

b) Sắp xếp danh sách theo thứ tự điểm tăng hoặc giảm dần 

Để sắp xếp bảng số liệu trên theo thứ tự giảm dần, bạn cũng làm tương tự các bước như 
đối với sắp xếp tên theo thứ tự bảng chữ cái. 

2.4. Thống kê và vẽ đồ thị số lượng HS theo từng mức độ/điểm 

Bước	1: Đầu tiên bạn mở bảng dữ liệu cần thống kê (Đặt tên sheet này là: Mức độ 
chi tiết). 
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Bước	2: Tạo 1 sheet mới lấy tên là Phổ điểm. Cách thực hiện như sau: 

- Ở cột “Mức độ” bạn nhập mức độ tương ứng 
(T, H, C). VD: A2 = T, A3 = H, A4 = C 

- Tiếp theo, tính số lượng HS theo từng mức độ 
bằng công thức như sau:  

B2 =COUNTIF('Mức độ chi tiết chi tiết'!K3:K13,'Phổ điểm'!A2) 

- Khi đó ta thu được số HS theo từng mức độ. 
Bước	3: Vẽ đồ thị số lượng HS theo từng mức độ: 
- Chọn cột cần thể hiện trên đồ thị > Insert > Insert Column or Bar Chart 

 

 
 
- Khi đó ta được đồ thị số HS theo mức độ như sau: 

 
 

- Tương tự ta có thể thống kê và vẽ đồ thị số lượng HS theo số điểm.  
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2.5. Tính toán điểm trung bình của một lớp, của từng HS 

 
Bước	1: Tính trung bình cộng (không có hệ số): Để tính điểm trung bình, tại ô K3, các 
bạn sử dụng công thức:  

= AVERAGE(E3:H9) 

Khi đó bạn nhận được kết quả: 

 
Bước	2: Tính điểm trung bình (có hệ số):  

Khi đó, tại ô J4, chúng ta sử dụng công thức sau để tính điểm trung bình:  
= (E4 + F4 + G4 + 2*H4 + 3*I4)/8 

Sau đó, chúng ta copy công thức cho các ô còn lại và nhận được kết quả như sau: 

 
Bước	3: Làm tròn điểm trung mình môn học:  

- Chọn ô mà bạn muốn định dạng, sau đó trên thanh Menu chọn mũi tên như hình 
sau: 
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- Tiếp đó, bảng Format Cells xuất hiện. Chọn Number > nhập số 1 (sau dấu phẩy 
lấy 1 chữ số). 

- Cuối cùng, ta được bảng kết quả như sau: 

 
 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/ENEc7bZ-Xiw 

V. Lựa chọn và sử dụng phần mềm thiết kế đa phương tiện 

1. Chụp ảnh  

2.1. Chụp ảnh bằng điện thoại di động hoặc máy chụp hình 

Tóm tắt các bước cơ bản:  

 

 

 Chọn khoảng cách đối tượng gần 

Lấy sáng cho đối tượng muốn chụp, giữ thiết bị không bị rung và nhấn nút 
chụp hình 
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2.2. Chụp ảnh màn hình máy tính 

Để chụp ảnh màn hình máy tính, có một số cách đơn giản sau: 

a) Chụp màn hình bằng bàn phím 

- Tùy thuộc vào máy tính, nhấn tổ hợp phím Windows + PrtSc hoặc Windows + Fn 
+ PrtSc. Khi đó, ảnh chụp màn hình sẽ được tự động lưu vào thư mục Screenshots 
có sẵn trên máy tính ở vị trí sau: This PC (hoặc My Computer) > Pictures > 
Screenshots. 

- Sau khi chụp màn hình bằng cách này, bạn có thể dán ảnh vừa chụp vào văn bản, 
phần mềm chỉnh sửa, cửa sổ chat, khung soạn thảo,… bất kì bằng cách sử dụng tổ 
hợp phím Ctrl + V.  

b) Chụp màn hình bằng Snipping Tool 

Snipping Tool cho phép người dùng chụp bất kì khu vực nào trên màn hình máy tính 
với khuôn khổ, kích thước nhất định. 

Bước 1: Khởi động Snipping Tool  
- Đối với Windows 7, Windows 10, tại ô Start gõ “Snipping 
Tool”. 
- Trên Windows 8 hoặc 8.1, nhấp vào biểu tượng tìm kiếm 
và nhập “Snipping Tool”  
Bước 2: Tại cửa sổ làm việc của Snipping Tool, nhấn chọn Mode để lựa chọn 1 trong 4 
tùy chọn sau để giới hạn phạm vi chụp ảnh trên màn hình: 

• Free – form Snip: Chụp ảnh tự do, viền ảnh và đường 
do bạn khoanh trên màn hình 

• Rectangular Snip: Chụp ảnh với khung hình chữ 
nhật 

• Window Snip: Chụp ảnh một cửa sổ đang mở 
• Full-screen Snip: Chụp ảnh toàn màn hình 

c) Chụp màn hình trên máy tính Macbook (MacOS) 

- Chụp ảnh toàn màn hình: Nhấn tổ hợp phím Shift + Command (⌘) + 3.  
- Chụp một phần màn hình tùy chọn: Nhấn tổ hợp phím Shift + Command + 4 > kéo 
chọn vùng bạn muốn chụp. Trong khi kéo, giữ phím Shift, Option hoặc Space để thay 
đổi cách di chuyển vùng chọn. Khi đã chọn xong, nhả chuột hoặc trackpad. Để hủy 
bỏ, nhấn phím Esc trước khi bạn nhả chuột.  
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Lưu ý: Ảnh chụp màn hình được lưu dưới dạng file *.PNG trên màn hình chính.  
d) Thiết kế hình ảnh bằng công cụ PowerPoint 

Từ các hình khối cơ bản trong Insert > Shapes, ta có thể vẽ hình ngôi nhà như hình 
bên. 
- Để đối tượng được giữ nguyên tỉ lệ, kích thước khi 
di chuyển, ta nhóm chúng lại bằng cách nhấn chuột 
phải chọn Group. Sau đó, nhấn chọn chuột phải vào 
hình hoặc group đó và chọn Save as picture để lưu 
hình ảnh như hình sau đây: 

 

2. Thiết kế và chỉnh sửa hình ảnh  

2.1. Công cụ Paint 

Bước 1: Mở công cụ Paint. Chọn Paste > Paste from để chọn ảnh cần chỉnh sửa. 
Bước 2: Thao tác chỉnh sửa với các tính năng: 
* Trong tab Home 
- Crop (cắt ảnh): Nhấn chọn Select để chọn phần hình ảnh muốn giữ lại, sau đó nhấn 
chọn Crop. 
- Resize & Skew (thay đổi kích thước và làm nghiêng): Nhấn chọn Resize >Resize 
and Skew với nhiều tùy chọn về thay đổi kích thước hoặc làm nghiêng ảnh.  
- Rotate & Flip: Quay và lật ảnh theo các góc và các hướng khác nhau.  
- Chèn text (chữ) vào ảnh: Chọn biểu tượng chữ A, sau đó đưa con trỏ chuột xuống 
vị trí muốn chèn và nhập text.  
- Chèn ảnh vào ảnh: Nhấn chọn Paste > Paste from và tìm đến hình ảnh muốn dán, 
chọn và nhấn Open (Mở).  



 47 

- Chèn một phần của hình ảnh khác vào hình ảnh 
đang sửa: Mở hình ảnh muốn sao chép trong Paint, 
Select và kéo chuột chọn vùng muốn sao chép, sau đó 
nhấn chuột phải chọn Copy (Ctrl + C). Mở đến hình ảnh 
muốn dán và chọn Paste (Ctrl + V).  
- Shapes: Vẽ thêm hình vào ảnh. 
- Tô màu với công cụ Fill with color: Nhấn chọn biểu 
tượng Fill with color (thùng sơn) như trong hình, sau đó 
nhấn chọn màu mà bạn muốn tô rồi đưa con trỏ chuột 
đến một điểm trong vùng mà bạn muốn tô màu. 

2.2. Công cụ PowerPoint 

a) Remove background (xóa bỏ nền của hình ảnh)  

Cách sử dụng tính năng này như sau:  

Bước 1: Chèn hình ảnh muốn xóa nền 

Bước 2: Trên thanh Ribbon xuất hiện tab Format (Picture Tools). Nhấn chọn vào 
hình ảnh, sau đó chọn Remove Background:  

 
Bước 3: Lúc này, hình ảnh đã chọn được chia thành 2 vùng. Vùng màu tím là vùng nền sẽ 
được xóa bỏ, vùng giữ nguyên màu gốc là vùng được giữ lại. Để điều chỉnh phạm vi của 
2 vùng này, người dùng sử dụng các nút đánh dấu vùng cần xóa bỏ hoặc đánh dấu vùng 
cần giữ lại như trong hình dưới đây: 
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Bước 4: Sau khi lưu thay đổi, ta thu được hình ảnh với nền đã được xóa bỏ như hình 
dưới đây. Khi chọn lưu thành tệp hình ảnh (Save as picture), hình ảnh được lưu dưới 
định dạng *.png sẽ có phần nền trong suốt.  

 
 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/NgT0ErafjrY 

3. Ghi âm/ thu âm 

Trong dạy học, GV có thể sử dụng đến các học liệu dạng audio (âm thanh) như băng 
ghi âm các bài hát, đoạn nhạc, câu chuyện, đoạn văn, đoạn hội thoại,...  

3.1. Ghi âm/Thu âm bằng điện thoại di động 

a) Ghi âm 
Bước 1: Chọn nút ghi âm trên điện thoại > Tiến hành ghi âm. 
Bước 2: Nhấn chọn file ghi âm vừa ghi để Sửa bản ghi/Nhân bản/Chia sẻ. 
b) Chia sẻ, lưu trữ file ghi âm từ điện thoại 

- Để chuyển các file ghi âm này từ điện thoại sang máy tính, bạn cần sử dụng các thết 
bị kết nối hoặc sử dụng các ứng dụng lưu trữ trực tuyến hoặc chia sẻ file trên điện thoại 
để gửi file ghi âm đó đi. Sau đó, sử dụng máy vi tính để tải file đã gửi về.  
3.2 Ghi âm bằng máy tính 

a) Đối với máy tính sử dụng Windows 7, Windows 8 
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❶ Mở Sound Recorder 

• Windows 7: Chọn Start và nhập từ khóa Sound Recorder vào ô tìm kiếm sẽ thấy 
xuất hiện Sound Recorder (biểu tượng micro). Nhấn chọn vào biểu tượng của 
phần mềm để mở.   

• Đối với Windows 8, di chuột vào cạnh bên phải màn hình để mở Menu Charms, 
nhấn vào biểu tượng kính lúp và nhập từ khóa Sound Recorder. Nhấn chọn vào biểu 
tượng của phần mềm để mở.  

❷ Nhấn chọn Start Recording để ghi âm. Thời gian ghi âm sẽ hiển thị trên thanh ghi 
âm để bạn biết được độ dài của đoạn ghi âm. 

❸ Khi đã ghi âm xong, nhấn chọn nút Stop Recording để dừng ghi âm. Ngay lập tưc, 
cửa sổ Save as sẽ xuất hiện. Chọn thư mục mà bạn muốn lưu file ghi âm và nhấn Save. 
Các file ghi âm thu được có định dạng là WMA. 

b) Đối với máy tính sử dụng Windows 10 
Sang đến phiên bản Windows 10, công cụ ghi âm trên được đổi tên thành Voice 
Recorder. 

❶ Mở Voice Recorder 

Nhấn chọn biểu tượng Windows (cửa sổ) ở 
góc dưới bên trái màn hình máy tính, bạn sẽ 
quan sát thấy danh sách các phần mềm và ứng 
dụng trên máy của mình. Kéo xuống phía dưới 
và chọn Voice Recorder.  

❷ Nhấn chọn vào biểu tượng Micro để bắt 
đầu ghi âm. Khi đó thời gian ghi âm bắt đầu chạy.  

❸ Các nút tạm dừng/dừng ghi âm được hiển thị như hình trên.   

❹ Ngay sau khi dừng ghi âm, danh sách các file ghi âm sẽ xuất hiện kèm ngày, giờ 
ghi âm và thời lượng đoạn ghi âm cụ thể. Phía bên phải là nội dung của đoạn ghi âm.  

Các nút chức năng phía bên dưới lần lượt là: 

(1) Share: Chia sẻ file ghi âm  

(2) Trim: Cắt đoạn ghi âm  
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(3) Delete: Xóa file ghi âm 

(4) Rename: Đổi tên file ghi âm 

c) Đối với máy Macbook (MacOS) 
Công cụ ghi âm có sẵn trên các máy Macbook là 
QuickTime Player.  

❶ Để mở QuickTime Player, vào Finder > 
Applications > File > New Audio Recording 

❷ Lúc này xuất hiện ô Screen Recording. Nhấn chọn vào nút tròn màu đỏ ở chính 
giữa để bắt đầu ghi âm. Trong trường hợp xuất hiện thông báo “QickTime Player would 
like to acess the microphone”, nhấn chọn OK.  

❸ Sau khi ghi âm xong, nhấn chọn nút vuông 
(Stop) để dừng ghi âm. Sau đó nhấn chọn File > 
Save as, lựa chọn thư mục muốn lưu file ghi âm và 
nhấn Save.  

3.3 Ghi âm bằng Audacity 

Giao diện làm việc của Audacity như sau:  

 
Trên giao diện làm việc của Audacity, ngay phía dưới thanh công cụ chính là các nút 
phục vụ cho quá trình thu âm: 

 

4. Biên tập, chỉnh sửa âm thanh 
4.1. Biên tập, chỉnh sửa, cắt ghép 

❶ Mở tệp tin 
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Chọn Menu > File > Open (hoặc nhấn tổ hợp phím Ctrl + O) tìm đến tệp âm thanh 
cần xử lí.  

❷	Cắt bỏ một đoạn âm thanh 

- Nhấn chuột vào vùng sóng âm để chọn thời điểm bắt đầu đoạn cần xóa. Tiếp theo 
nhấn giữ chuột và rê về phía bên phải để lựa chọn điểm kết thúc. 

 
- Nhấn chuột vào biểu tượng cây kéo (hoặc nhấn nút Delete, Ctrl + X) để xóa đoạn 
âm thanh đã chọn. 

❸ Tách một đoạn âm thanh ra tệp mới 
Nhấn chuột vào cùng sóng âm để chọn thời điểm bắt đầu đoạn cần tách. Sau đó 
nhấn chọn Menu > File > Export > Export Selected Audio,…  

4.2. Các hiệu ứng (Effect) của Audacity 

Bước 1: Chọn đoạn âm thanh muốn áp dụng hiệu ứng. 
Bước 2: Chọn Effect (trên thanh công cụ) để xem các hiệu ứng. Chọn một hiệu ứng 
bất kì, có sẵn các nút Preview/Playback để bạn có thể duyệt qua đoạn âm thanh vừa 
được hiệu chỉnh. 
Bước 3: Bấm Apply/OK để áp dụng hiệu ứng. Một số hiệu ứng thường dùng: 

❶ Lọc bỏ tạp âm (Noise Reduction) 

- Nhấn chọn Menu > Effect > Noise Reduction 
- Nhấn chọn Get Noise Profile. Lúc này màn hình 

trở về giao diện chính của Audacity. Bấm chọn 
khoảng có nhiều tiếng ồn, sau đó mở lại bảng 
điều khiển hiệu ứng bằng cách nhấn chọn Menu 
> Effect > Noise Reduction 

- Điều chỉnh các thông số và bấm Preview để nghe 
thử âm thanh sau khi lọc, sau đó nhấn OK để phần mềm tiến hành loại bỏ tiếng ồn.  
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❷ Điều chỉnh âm lượng của tệp tin hoặc đoạn âm thanh: Effect > Amplify > Allow 
clipping > OK 

❸ Điều chỉnh tốc độ âm thanh: Effect > Change Speed 

5. Quay video  
5.1. Quay video bằng điện thoại di động hoặc máy quay (máy ghi hình) 

Bước 1: Mở Camera để tiến hành quay. 
Bước 2: Chọn nút dừng để ngưng quay. Khi đó vide được lưu trong thư viện điện thoại 
5.2. Quay video màn hình máy tính 

a) Quay video màn hình máy tính bằng PowerPoint 
Quay video màn hình máy tính là tính năng mới, được cung cấp 
ở các phiên bản từ Office 2013 trở về sau.  

Bước	1: Nhấn chọn tab Insert, trong nhóm công cụ Media, nhấn 
chọn Screen Recording. 

Bước	 2:	 Lúc này bảng điều khiển của 
Screen Recording hiện lên. Chọn Select 
Area > Chọn phạm vi muốn ghi hình.  

Bước	3: Trên bảng điều khiển, bạn có thể 
bật tắt 2 tính năng Audio (ghi âm thanh) và 
Record Pointer (ghi con trỏ chuột). 

❹ Nhấn chọn (Record) để bắt đầu ghi hình.  

❺ Nhấn tổ hợp phím Windows + Shift + Q để ngừng ghi hình.  

Style (phong cách) hoặc Trim (cắt sửa). Để lưu thành tệp video, tiếp tục nhấn chuột 
phải vào video và chọn Save Media as. 

Xem chi tiết video hướng dẫn: 

 

Youtube Link: 

https://youtu.be/uyEkW6GFvIg 
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5.3. Quay video màn hình bằng Bandicam 

Để quay màn hình với phần mềm này, chúng ta thực 
hiện như sau:  

❶ Trước khi quay video màn hình, ta cần thực hiện một số thiết lập: 

- Nhấn chọn tab Tổng quát: chọn thư mục lưu video sau khi quay. 
- Nhấn chọn tab Video: thiết lập các hiệu ứng, định dạng video và phím tắt quay/dừng 

video. 
- Nhấn chuột vào dấu mũi tên bên trái màn hình để chọn vùng quay trên màn hình.  

 
❷	Khi đã chọn phạm vi khung hình, nhấn chọn REC ở phía bên phải để bắt đầu ghi 
hình. 

 
❸	Nhấn chọn nút REC để dùng ghi hình. Video đã được tự động lưu ở thư mục đã 
thiết lập ở bước 1.  

6. Biên tập video 

6.1. Sử dụng VivaVideo 

a) Cài đặt 
Để cài đặt VivaVideo, bạn cần tìm kiếm ứng dụng này trong kho ứng dụng trên thiết bị 
của mình (Google Play đối với Android và AppStore đối với IOS) và tiến hành cài đặt.  

b) Sử dụng VivaVideo 
Giao diện của VivaVideo khá đơn giản với 3 nút sử dụng 
chính: 
- Edit: Chỉnh sửa video 
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- My drafts: Các bản nháp của video, slideshow đang chỉnh sửa. 
- Slideshow: Tạo video từ ảnh  

Khi tiến hành chỉnh sửa giao diện chỉnh sửa của VivaVideo 
có dạng như hình bên, trong đó:  

- Thanh công cụ: X (đóng), Undo, Redo, Draft, Save. 
- Xem thử video 
- Nhóm công cụ:  

• Theme: cho phép chọn từ danh sách các mẫu video 
với nhiều chủ đề có sẵn. 

• Music: cho phép xóa/chọn/ghi âm trực tiếp. 
• Clip Edit: Cho phép crop/tăng giảm tốc độ/âm lượng 

của video. 
• Text & Fx: Cho phép thêm/chỉnh sửa,... 
• Filter: bộ lọc màu video. 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

 

Youtube Link: 

https://youtu.be/RqlBrkFTqTk 

 

6.2. Sử dụng VSDC Video Editor 

a) Biên tập video với VSDC Video Editor  
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❶	Nhấn chọn Blank Project > điền các thông tin và nhấn Finish. 

❷	Kéo thả tệp vào vùng màu đỏ (Timeline) 

❸ Tại vùng màu xanh lá, bạn có thể thêm vào những nội dung như video, nhạc, 
text, hình ảnh,... 

b) Xuất video 
Để xuất video, ta lựa chọn và thay đổi các tùy chọn tại tab Export project: 

 

7. Lưu trữ và chia sẻ video 
Do dung lượng tương đối lớn, từ vài chục MB đến vài GB tùy thuộc chất lượng và độ 
dài của video nên dễ dàng lưu trữ và chia sẻ video, ta thường sử dụng các nền tảng chia 
sẻ video. Trong đó phổ biến nhất là Youtube, tại địa chỉ https://www.youtube.com.  

7.1. Tải video lên Youtube 

❶ Đăng nhập vào Youtube Studio. 

❷ Ở góc trên cùng bên phải màn hình, nhấp vào biểu tượng máy quay Tạo > Tải 
video lên 

❸ Tìm đến thư mục lưu trữ và chọn tệp video mà bạn muốn tải lên.  

❹ Thêm các thông tin cơ bản như tiêu đề, nội dung mô tả,… cho video của bạn.  

❺ Tùy chọn các cài đặt nâng cao như từ khóa, 
ngôn ngữ và phụ đề, bật/tắt bình luận,... 

❻ Xem trước và xuất bản video.  

7.2. Chia sẻ video  

Để chia sẻ một video bất kì trên Youtube, 
Nhấn chọn Copy để sao chép đường link của 
video; sau đó dán (Paste) đường link này và gửi 
cho người bạn muốn chia sẻ.  
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Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

Youtube Link: 

https://youtu.be/p0mPUbcCZKI 

 

VI. Tìm kiếm và khai thác thông tin tư liệu phục vụ dạy học  

1. Tư liệu hình ảnh 

Để khai thác hiệu quả nguồn tài nguyên ảnh có sẵn từ Internet này, GV cần trang bị cho 
mình các kỹ năng tìm kiếm và chọn lọc dữ liệu hình ảnh nhất định. Sau đây, chúng tôi 
giới thiệu một số kĩ năng tìm kiếm hình ảnh với công cụ tìm kiếm Google tại địa chỉ 
https://images.google.com/: 

1.1. Tìm kiếm hình ảnh bằng từ khóa 

Nhập từ khoá tìm kiếm (thông thường từ khoá bằng tiếng Anh sẽ giúp tiếp cận với lượng 
kết quả nhiều và phong phú hơn). 

1.2. Tìm kiếm nâng cao 

Nhấn chọn Tools (hoặc Công cụ) tìm kiếm với các tùy chọn đi kèm. Lúc này, hiện ra các 
tùy chọn với hình ảnh như hình: 

 
• Kích thước (Size) – độ lớn, nhỏ của ảnh  
• Màu (Color) – màu sắc chủ đạo của ảnh 
• Loại (Type) – loại ảnh muốn tìm kiếm   
• Time (Thời gian) – thời gian ảnh được đăng  
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1.3. Tìm kiếm bằng hình ảnh  

Bước	1:	Nhấn chọn biểu tượng máy ảnh như hình dưới đây: 

 
Lúc này ô Tìm kiếm bằng hình ảnh (Search by image) xuất hiện: 

 
Bước 2:	Tại đây, bạn có thể lựa chọn các cách sau để đưa hình ảnh vào tìm kiếm:  

• Dán URL của hình ảnh: Nhấp chuột phải vào hình ảnh bất kì trên Internet > Sao 
chép địa chỉ hình ảnh (Copy image address) > Dán địa chỉ vào ô tìm kiếm > Nhấn 
Tìm kiếm bằng hình ảnh/Enter. 

• Tải ảnh lên: Chọn Tải ảnh lên > nhấn chọn hình ảnh trên máy tính > Mở (Open). 

2. Tư liệu âm thanh(Audio) 
2.1. Các hiệu ứng âm thanh (Sound Effect) 

• Trong quá trình dựng các đoạn ghi âm/ video,... bạn cần sử dụng đến các âm thanh 
minh họa cụ thể như như: tiếng nổ, tiếng động vật, tiếng xe cộ, tiếng gió, mưa, tiếng 
chuông điện thoại, tiếng bàn phím,... được gọi chung là các hiệu ứng âm thanh.  

• Để tìm kiếm các hiệu ứng âm thanh, ngoài cách sử dụng từ khóa tiếng Việt, bạn có 
thể sử dụng từ khóa “Sound Effect” để cho ra các kết quả phong phú hơn.  
Ví dụ: Khi tìm kiếm với từ khóa “Rooster Sound Effect” hoặc “Morning Rooster 
Sound Effect” sẽ cho ra kết quả là tiếng gà gáy sáng.  

2.2. Các loại nhạc nền (Background Music hay BGM) 

• Nhạc nền là các bản nhạc được dùng để tạo không khí (vui vẻ, sôi động, buồn,...), 
thường có kết cấu khá đơn giản và không gây quá nhiều sự chú ý của người nghe.  

• Để tìm kiếm nhạc nền, ngoài cách sử dụng từ khóa tiếng Việt, bạn có thể sử dụng từ 
khóa “Background Music” hoặc “BGM”.  
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2.3. Một số trang web chia sẻ audio miễn phí 

Tên thư viện Nội dung 

Youtube Audio Library Nhạc và hiệu ứng âm thanh 

Facebook Studio Nhạc và hiệu ứng âm thanh 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

 
Youtube Link: 

https://youtu.be/rtGtpVXr6wg 

3. Template bài trình chiếu PowerPoint  
Với sự phổ biến của PowerPoint hiện nay, người dùng có thể sử dụng các mẫu thiết kế 
có sẵn (templates, themes) và thay đổi nội dung sao cho phù hợp với bài giảng của 
mình. Một số nguồn cung cấp template miễn phí: 

• Thư viện của PowerPoint 
• Thư viện của Google Slides 
• https://slidesgo.com/ 

Xem chi tiết video hướng dẫn: 

 
(Scan để truy cập) 

 
 

Youtube Link: 

https://youtu.be/B0M51dyzwiY 
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4. Thí nghiệm ảo, thí nghiệm mô phỏng  
Để sử dụng các thí nghiệm ảo, các mô phỏng tương tác đối với các môn khoa học tự 
nhiên và Toán học trong dạy học trực tuyến, GV có thể tìm kiếm và khai thác miễn phí 
loại tư liệu này tại https://phet.colorado.edu/vi/ 

 
 
Trong danh mục các mô phỏng, đánh dấu vào ô trống ứng với lĩnh vực mà bạn muốn 
tìm kiếm và lựa chọn trong các kết quả:  
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PHỤ	LỤC	2:	VIDEO	VÀ	TÀI	LIỆU	THAM	KHẢO	
(Scan các QR code hoặc kích chuột vào các link dưới đây để truy cập) 

1. Thực hiện kế hoạch bài dạy trực tuyến “Đo chiều dài” 

 

Youtube Link: 
https://youtu.be/XRLsvE0cQss 

2. Sinh hoạt chuyên môn phân tích việc thực hiện dạy học trực tuyến 

 

Youtube Link: 
https://youtu.be/pNtVXBTK1gY 

3. Xác định mục tiêu bài học 

 

Youtube Link: 
https://youtu.be/CtrFEzBajG0 

4. Xác định mục tiêu từng hoạt động trong tiến trình dạy học 

 

Youtube Link: 
https://youtu.be/_414LgxxCeU 

5. Thiết kế hoạt động 

 

Youtube Link: 
https://youtu.be/unyfiCTGxs8 
Ví dụ về thiết kế hoạt động: 

https://youtu.be/-5ObjEve-u8 
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